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Getting Started The introductory guide to install and run the server in standalone mode and domain, how to distribute a data source and how to use the web management interface and the command line interface to manage the server. Administrator's Guide A complete guide for configuring and administration of the application server. High
availability guide A guide on how to create a cluster, how to configure the web container and the E]JB container for clustering and show to configure the balance and failover of the load. Developer Guides Getting Started To Develop Application Guide It introduces you to write simple Java and EE 6 applications and distribute them on the application
server. Each tutorial is accompanied by a quick startup application. Finally, the guide shows how to create your application skeleton. Developer Guide A complete guide for all distribution descriptors and bees available on the application server. Java exercise and a complete guide for the development of Java EE 6 applications for JBOSS AS. To replace
this page set "Enable-welcome-root" to false in the server configuration and distribute your war with / as a context path. Show the content table JBoss Enterprise Application Platform 6Dition 3abstract This book is a guide to the administration and configuration of the JBoss Enterprise 6 application platform and its patch relationships. JBoss
Application Server is the Java Leader, Open Source Market Platform, Enterprise Edition (Java EE) Application Server, offering a high-performance and enterprise platform for e-business applications. JBoss offers enterprise-class security, transaction support, resource management, load balancing and clustering. JBoss Partition is a logical grouping of
JBoss application servers within the corporate configuration. The status of the JBoss partition depends on the state of all its members, ie the JBoss application servers within the partition. Enterprise Manager Cloud Control allows you to discover JBoss application servers and JBoss partitions in your environment and add them for monitoring and
central management. This chapter describes how you can discover and monitor these Jboss Application Server targets in the cloud manager Enterprise Manager control. In particular, this chapter concerns the following: Using the cloud manager control Enterprise, you can do the following operations with JBoss Application Server: find out the
following for central monitoring and management: JBoss Application Server JBoss Partitions When you find a server JBoss application that is part of a JBoss partition, the JBoss partition and all other JBoss application servers that are part of that JBoss partition is displayed automatically and added to the control of the Enterprise Manager Cloud
Manager. Monitor the status, the percentage of availability, the use of the CPU, the use of the HEAP, the Java supplier and the version used and so on. Monitor the state and general health of member application servers that are part of JBoss partitions. Monitor the performance by measuring the load and processing time for a specific range. Diagnose,
notify and correct performance and availability problems with the help of GUI rich graphs and illustrations, intuitive. Monitor the status of distributed applications. Monitor servlets and JSPs running on application servers, including the most requested servlets in the last 24 hours. View details on associated JVM threads and data sources. Create or
terminate the blackouts to suspend or resume the collection of metric data respectively. Monitor and manage the Configuration that have been collected and even those who have been saved at a given time. Compare the configuration between: one last configuration collection of a server instance with a saved configuration of the same server instance
or a different server instance. One last configuration collection of a server instance with a last configuration collection of a different server instance. A saved configuration of a server instance with another another Configuration of the same server instance or a different server instance. A configuration of a server instance saved with a last
configuration collected from the same server instance or a different server instance. View compliant information, such as compliance standards and frameworks associated with the server, real-time observations, evaluation results, and so on. View a list of metrics, their collection interval, and the latest loading for each metric. To check the versions of
JBoss Application Server that are supported for identifying and monitoring in Enterprise Manager Cloud Control, follow these steps: Log in in the My Page Oracle Support, select the card Certifications. On the Certifications page, enter the following search criteria in the Certification Search section. Enter the product name Enterprise Platform Base
Manager - OMS in the product field. Select the release number 12.1.0.4.0 from the output list. Click Search. In the Results Certification section, expand the Application Server menu to view the JBoss Application Server certified versions. Meet the following prerequisites to discover JBoss Application and JBoss Partitions servers. Be sure to use only
Oracle Management Agent 12c Release 3 (12.1.0.3) or higher for the discovery. Be sure to download and extract the JBoss Application Server zip file, and set the JBDSS HDME and PATH environment variables as follows: SENENV JBOSS HOME SEENV PATH "$ {PATH}: / $ {JBOSS HOME} / bin" if JBoss is added 4.x application server or 5.x, then
make sure the following requirements are met: In the Run.conf file that is present in the / bin, add the following items: JBoss Application Server 4.x brand a note Of the door used here, as the door itself must be used for the discovery. Java opts = "$ java_opts -dcom.sun.management.jmxRemote.port = " any unused port java opts = "$ java opts -
dcom.sun.management.jmxremote.authenticate = false" java opts = "$ java opts -dcom.sun.management. jmxremote.ssl = false "java opts =" $ java_opts -djboss.platform.beanserver "java opts =" $ java_opts -djavax.management.builder.initial = org.jboss.system.server.jmx.beanserverbuilderimpl "5.x Jboss Application Server Java opts = "$ java opts
-djboss.platform.beanserver" Restart JBoss Application servers. Make sure that you start the JBoss Application Server or the JBOSS partition by running the following command from the bin directory: ./run.sh -c -b [-djboss.partition.name = ] Here, < deployment profile> Indicates if an autonomous JBoss Application Server or a JBoss partition starts.
The is the host name or IP address that runs the JBoss Application Server. The is the partition name from which JBoss Application servers must start. By default, begin as part of defaultPartition. For example, ./run.sh -c nodel -djboss.service.binding.set = ports-01 -b example.oracle.com to Discover JBoss Application and JBoss Partitions, follow these
steps: Select Middleware from the Targets menu . On the Middleware page, select JBoss Application Server from the Add menu. Click Go. Enterprise Manager Cloud Control displays the Discovery JBoss wizard. On the Host page, enter the data about the host on which the JBoss Application Server is running. Figure 35-1 JBoss Application Server Host
Page On the Select Server page, view a list of JBoss Partitions and Standalone JBoss Application servers discovered on the specified host, and to select those you want to add and monitor in Enterprise Manager Cloud Control. Figure 35-2 JBoss Server Select Server Page on the Review page, review the data you provide for the discovery and addition of
Cloud Control JBoss Enterprise Manager lenses. Click Submit to find out JBoss goals. JBoss Application Server Monitoring with Enterprise Manager Cloud Cloud 12C Release 3 (12.1.0.3) or lower with Oracle FMW Plug-in 12.1.0.5 or lower was essentially based on Java EE EJB (Mejb) management, a JSR-77 standard mode to expose business
management functionality. However, starting from the Control Manager Enterprise Cloud 12c Release 4 (12.1.0.4), JBoss Application Server monitoring is based on Java Management Extensions Technology (JMX). With this change in technology, Enterprise Manager Cloud Control now eliminates the need to distribute the Jar Mejb (E]JB-
Management.jar) file on a host where JBoss Application servers are running, which was previously a prerequisite for the discovery. In addition, Enterprise Manager Cloud Control now offers new, additional, enriched metrics. Oracle strongly recommends that it moves to JMX-based monitoring in order to benefit from the improvements of the new
approach offers. Otherwise, the JBoss Application server monitoring will continue to be done using Mejb, recently introduced metrics will not appear, and the assumption of the distribution of the Jar Mejb file as a prerequisite for the discovery will continue to exist. For JBoss Application servers already discovered and monitored in 12C Cloud Control
Enterprise Manager version 3 (12.1.0.3) or lower with Oracle FMW Plug-in 12.1.0.5 or lower, proceed as follows: Update both Oracle Service Management and Oracle Management Agent of 12c Release 4 (12.1.0.4) or higher. Update the Oracle FMW Plug-in for 12.1.0.6 or higher. JMX-based monitoring migration. From the Targets menu, select
Middleware. On the Middleware page, do one of the following conditions: For Standalone JBoss Application (I) servers on the Middleware page, click the desired JBoss Application Server. (Ii) On the JBoss Application Server home page, select the destination installer, then select Migration to USA JMX. (Ilii) On the USA JMX migration page, enter the
JMX port to use for the selected JBoss Application Server. (Iv) Click Send. For JBoss Application servers that are grouped into a JBoss (I) partition on the Middleware page, click on the JBoss partition. (Ii) On the JBoss Partition page, from the JBoss Partition menu, select the destination installer, then select Migration to USA JMX. (Iii) On the Migration
page to USA JMX, JMX ports enter for all JBoss Application servers that are part of the partition. (Iv) Click Send. For the new JBoss Application servers to be discovered and monitored in 12C Cloud Control Enterprise Manager Release 4 (12.1.0.4), do the following: Update both Oracle Service Management and Oracle Management Agent at 12¢
Release 4 (12.1.0.4) or higher. Update the Oracle FMW Plug-in for 12.1.0.6 or higher. Distribute a host management agent on which the JBoss Application Server to discover is running. For instructions, see Installing an Oracle Fresh Management Agent. Add the JBoss Application Server Enterprise Manager Cloud Control. For instructions, see Adding
JBoss Application Server. This section describes the following: To monitor JBoss Application servers, follow these steps: from the Targets menu, select Middleware. On the Middleware page, click on the desired JBoss Application servers. On the JBoss Application Server page, you can view a summary of the most critical information about JBoss
Application Server. You can view general information on the server, information on servlet and JVM wires running on the server, and the performance synthesis in terms of load and response time. The JBoss Partition Home Page has the following sections: provides a graphical representation of server performance, measuring time processing time For
a given interval. To switch to a tabular format, click Table View. To view in detail the more detailed metric information and to diagnose problems, looking for other metrics connected infrastructures, click Metric names in the legend and select an appropriate option in the message Additional information. Provides the details of the most requested
servlets in in Last 24 hours. To administer the JBoss application servers, follow these steps: from the Target menu, select Middleware. On the Middleware page, click the desired JBoss Server Application Server server. On the JBoss Application Server home page, you can view high-level information about the selected JBoss application server. To run
Administrative Activities on the JBoss application server, from the JBoss Server menu, select one of the following operations based on the needs: Monitoring, to monitor target performance, view metric details, view status information, accidents view and raised notices So indeed for the target and view the blackouts created for the target. Diagnostics,
to analyze and diagnose performance problems. Check, create or terminate the blackouts. Working activity, to view the details of the jobs created for the target. Publishing Reports Publisher, to view reports. Configuration, to search, view and compare configuration details. Conformity, to view and create compliance standards. Destination setup, to
view the monitoring configuration details and destination properties, to remove the target or add it to a group, to migrate and use JMX. Target Sitemap, to view the overall target topology. Destination information, to view general objective information. To monitor the applications distributed to JBoss Application Server, follow these steps: from the
Target menu, select Middleware. On the Middleware page, click on the JBoss application server in which servlets and JSPs are implemented. On the JBoss Application Server home page, select Monitoring, then select Performance Summary. On the performance summary page, scroll down to the Applications section. Enterprise Manager Cloud Control
helps to monitor general performance of JBoss application servers. You can view the graphs that depict their use of the memory and use of the HEAP and see the details on the servlets and JSPS. This helps you evaluate performance and perform an analysis of the main proceedings to drill down to problem areas and solve them before influencing end
users. To monitor the performance of a JBoss application server: from the Target menu, select Middleware. On the Middleware page, click on the JBoss application server whose performance you want to monitor. On the JBoss Application Server home page, select Monitoring, then select Performance Summary. On the performance summary page, you
can do the following: View a series of performance graphs, monitor performance on a certain range and diagnose and correct problems. Personalize the set of performance graphics that appear on the page. To do this, click Show Metric Palette and select the graphs you want to add to the page. Show or hide the metric palette. To do what, click Show
the metric palette or hide the metric palette respectively. Reorder performance graphs. To do this, from the View menu, select the reordable graphics. Customize performance graphs to show or hide availability and threshold details and grid lines. To do this, from the View menu, select Availability, thresholds or grid lines, respectively. Draw a
comparison with other performance of IBM WebSphere Application Server, or with the performance of the previous day. To do this, from the Compare menu, select with another server IBM or today with yesterday, respectively. Remove the comparison. To do this, from the Compare menu, select Remove Comparison. Create or delete the base lines. To
do this, from the Compare menu, select Create the base line or delete the base line, respectively. Delete the graphs of metric performance by clicking the Close button on the graph itself, or by deselecting the metric name in the metric palette. Change temporal frames using the cursor or set a default value. Create new graphs of metric performance
by selecting the preferred metrics from the metric palette. The graphs are automatically created once the metrics are selected. Drag and release metrics from a particular metric group to the same graph. Business enterprise Cloud Control allows you to monitor servlets and JSPs running on the JBoss Application Server. You can not only view high-
level information about them, but also a list of the features that reflects their response time and load. You can also dirll down and diagnose problems with displaying metrics of related infrastructure, alert history, and so on. To monitor the servlet and JSP running on JBoss Application Server, follow these steps: On the Targets menu, select Middleware.
On the Middleware page, click on the JBoss application server in which servlets and JSPs are implemented. On JBoss Application Server Home page, do this: To view high-level information about the servlet, see the Servlet region. To understand the metric details displayed in this region, click Help. To monitor the performance of servlet and JSP, see
the response and load graphics. To drill down and diagnose problems, click a metric name in the legend. From the pop-up message, click Troubleshooting. To view the statistics metrics, thresholds, and history metric value, click a metric name in the legend. From the pop-up message, click metric details. To view all metrics JBoss Application Server,
follow these steps: On the Targets menu, select Middleware. On the Middleware page, click the desired JBoss Server Application Server server. On JBoss Application Server Home page, from the JBoss Server menu, select Monitoring and select all metrics. For information on the metrics of performance peaks, you can use the page Problem Analysis to
compare the results between the metric source and related metrics. Currently, the analysis of the problem is only available for the following metrics. Server CPU Usage Servlet and JSP - the processing time for requests to access the page analysis of the problem, follow these steps. From a performance summary page, click the name of the next metric
in the performance graph. From the window that opens, select Troubleshooting. In the analysis of the problem page, you can compare the results of metric origin and related metrics. This section describes the following: To monitor JBoss partitions, follow these steps: On the Targets menu, select Middleware. In the Middleware page, click on the JBoss
desired partition. In JBoss partition home page, you can do the following: display a summary of the most critical information related to JBoss partition. Monitor the status and the availability of all components within the JBoss partition. Display the status update on the partition composition. Using the partition homepage JBoss, it can not only monitor
the collective state of the partition, but also of each individual member state. You can also update the partition to update the membership and to reflect the current status of the distribution. You can also view the use of application servers member of the resources, the availability, performance, configuration information, and relationships with or
without historical data. The JBoss partition home page has the following sections: Section General Section Refresh Partition Server section The General section provides general information on JBoss partition. The breakdown of the display section updates the date on which the JBoss partition of the last update. To update the membership of the JBoss
partition and to reflect the current status of the distribution, click Update the partition. Section Server provides real-time display of the status and availability of all Inside the JBoss partition. For example, if there are four jboss servers application within a jboss partition, and if three of these are, then the graphic cake indicates 75% and 25% of status.
Accordinlgy, Legend 3 shows against the status to indicate JBoss Application servers that are up and 1 against the status down to indicate the server that is below. The table provides high-level JBoss Application servers that are part of the JBOSS partition. To drill down and view information about a JBoss Application Server, click the JBoss Application
Server name. Server. View more information on the status, click the status icon. To administer JBoss Partitions, follow these steps: From the Destinations menu, click Middleware. On the Middleware page, click the desired JBoss partition target. On the JBoss Partition Home page, you can view high-level information belonging to the selected JBoss
partition. To run Administrative Activities on the JBoss partition, from the JBoss Partion menu, select one of the following according to your needs: Monitoring, to monitor target performance, view metric details, status information, accidents view and alarms detected so far for The target, and view the blackouts created for the destination.
Diagnostics, to analyze and diagnose performance problems. Check, create or terminate the blackouts. Working activity, to view the details of the jobs created for the target. Publishing Reports Publisher, to view reports. Members, to view the details of JBoss Application servers that are part of the JBoss partition. Configuration, to search, view and
compare configuration details. Conformity, to view and create compliance standards. Destination setup, to view the monitoring configuration details and destination properties, to remove the target or add it to a group, to migrate and use JMX. Target Sitemap, to view the overall target topology. Destination information, to view general objective
information. Enterprise Manager Cloud Control allows you to update the membership of a JBoss partition so that it can reflect the current distribution status. This allows you to add additional JBoss Application servers for the existing JBoss partition. To update a JBoss partition, follow these steps: From the Destinations menu, click Middleware. On the
Middleware page, click the desired JBoss partition target. On the JBoss Partition Home page, in the Partition Refresh section, click Update Partition. Enterprise Manager Cloud Control leads to the Host partition credentials update. For information on this page, click Help on the page. On the Credentials Host Refresh Partition Agent page, provide host
credentials on which the management agent, which was used to find out the existing JBoss Application Server members, is running. On the partition Update Add Members page, select Standalone JBoss Application servers that should be added to the JBoss partition. Enterprise Manager Cloud Control Displays members of a JBoss partition. You can see
what kind of members form the partition, monitor the status, and run various administrative operations to view a list of members, follow these steps: From the Destinations menu, click Middleware. On the Middleware page, click the desired JBoss partition target. On the JBoss Partition Home page, from the JBoss partition menu, select Members, then
select Show all to view the following details of the members. To search for a particular element, use the search menu. By default, all JBoss partition members are listed in the table. To update the table and view only a particular type of components, select direct or indirect members members from the View section. To capture the configuration details
of belonging in a spreadsheet, click Export. of Cloud Control Oracle Enterprise Manager 12C JVM Diagnostics allows administrators of performance problems diagnosing in a Java application in a production environment. Eliminating the need to reproduce problems, reduces the time required for These problems. This improves application availability
and performance. The correlation between the target and the JBoss JVMD / JVM target allows administrators to surf the JVM in a context of JBoss Application Server. To distribute JBoss on JVMD, complete the following: From the Settings menu, select Middleware Manager, then select Application Performance Management. On the Application
Performance Management page, select Diagnostic JVM motors, and then click Configure. From the JVM card and pools, click Download. Figure 35-3 Download JVM JVM Components From the window Download JVM Diagnostics Components, select JVMD Agent, then click OK. From the window of the parameters of the JVM Diagnostics Web.xml Agent,
select the appropriate JVMD manager from the list of available managers. Figure 35-4 Diagnostic Agent JVM Agent Web.xml parameters Clear the Weblogic Server check box, enter a pool name, then click Download. This will download the file Jamagent.war. You must copy this file to the target machine (the machine is running JBoss). Copy the script
contained in the following location to the same location on the target machine where Jamagent.War. The file was copied: 20mw/public%20documents/makejamagents.sh Run the script passing the names of the JBoss instances (or whatever name you give to the JVM on each JBoss server). The name must be unique to each server. This script will create
a separate jamagent war for each name passes to this script. Distribute each of these wars created on the respective JBoss server. Generally you can use the administrative console or copy the war file to the Deploy folder. If the heat distribution is not enabled, you may need to restart the JBoss server. Once the war is delivered successfully, you will
see the corresponding JVM goal on middleware page. This section provides tips for troubleshooting issues encountered during the discovery or monitoring of the JBoss application server. 35.9.1 Troubleshooting Monitoring Problems If the state of destination is not active after the discovery, control the monitoring Property page for the JBoss
application server and verify the following: Local Discovery: This is only JBoss Home Remote Discovery : only the path of the library is available if the target state is present A pending (due to a metric collection error) after the discovery, ensure that no other application server to be monitored using the same agent management (such as WebLogic).
The various log resort are the various localities log: JBoss Server Logs: $ JBOSS HOME / Server / / Log WHO records: emoms.trc (under $ oms _home) agents Accessories: $ agent state dir / sysman / log on error discovery JBoss, Provide the path of the library along with the house installation and try again. For questions related to the discovery,
manually run the discovery script to verify the output, which should look similar to the following: Java -Doracle.Home = \ -CP \ /lib/xmlparserv2. jar: \ /jlib/emconfiginstall.jar: \ /sysman/jlib/log4j-core.jar: \ /modules/oracle.http client 11.1.1.jar: \ / archives / em -as-Thantparty -Discovery.jar \ oracle.sysman.emas.thirdparty.discovery.jboss.jbossdiscovery \
"" the information on the useful troubleshooting can also be found by checking the following: configuration of Tunti monitoring Targets.xml WHO and the agent Agent logs Agent Metric Browser JBoss JMX Console JConsole JBoss Server logs logs
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